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About this document 

 

This document is a reference guide for the InfoFlex Query Design Manager module.   

This document can also be used as a training guide in conjunction with the CIMS General training 

database.  Wherever appropriate, exercises are included at the end of a section. 

 

The exercises in this document use the CIMS General training database. 

 

 

 

 

 

 

 

 

 

The Username is training  and the Password is training . 

 

Before starting the exercises, you should login to the CIMS General training database, go to Design 

Management and ensure that the following domains and data views are unarchived: 

 

§ Clinical Domain 

§ Clinical Data view 

§ Training Domain 

§ Training Data view 
 

 

This document assumes that the user is familiar with InfoFlex Design Management 1 and 2. 
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1 ABOUT QUERY DESIGNMANAGER  

 

1.1 About Query Design Manager 

 

Query Design Manager is the InfoFlex tool that allows the user to define views, filters and queries and 

to run queries to extract data. 
 

A View defines which items of data will be returned. 

A Filter defines which subset of patients or records you wish to view the data for. 

A Query links a view and a filter together and sets certain query parameters which control how the 

view and filter are linked together. 
 

In Query Design Manager you can view and edit existing views, filters and queries and you can create 

new views, filters and queries.  You can also run queries and export the resulting data. 
 

Queries are used in many places in InfoFlex eg 
 

¶ Data Analysis ¶ Scheduler 

¶ Reporting ¶ Bed Manager 

¶ Work List ¶ Add-Ins eg the Extract Add-In for the production of 

data extracts. ¶ Data Entry subject searches 

 

Within QDM, the following symbols are used: 

 

  represents a query group 
 

  represents a query 
 

  represents a view 
 

  represents a filter 

 

 

Query Design Manager will be referred to as QDM  throughout this manual. 

 

1.2 Domain and data view queries 

 

Queries can be defined both within domains and within data views.  Queries cannot be moved or 

copied between a domain and a data view, so it is important to define your queries in the correct 

location.  The location a query should be created in is governed by the purpose of the query.   

 

For example, queries for use in documents and reports are defined on the domain since documents and 

reports are defined at domain level.  However, queries for use in Data Analysis are defined in the Data 

View since access to Data Analysis is granted by data view, and the data items available need to be 

limited by user permission. 

 

When defining a query for a particular purpose, it is therefore important to know whether the query 

should be in a domain or a data view before defining it.  Note that event view summaries can use both 

domain and data view queries.  Queries defined on the domain can be used in event view summaries in 

any data view, whereas queries defined on a data view are only available for event view summaries 

defined within that data view. 

 

The examples shown in this document use queries in data views, however the functionality is the same 

whether queries are being defined in domains or data views. 
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1.3 Accessing QDM 

 

QDM can be accessed from the Actions menu in the Design Management and Data Analysis modules. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

QDM can also be launched from toolbar buttons in the Design Management and Data Analysis 

modules. 

 

  
 

QDM displays one domain or one data view at a time.  You must select the domain or data view in 

which you want to define your queries before you open QDM. 

 

When QDM is opened, it displays either domain queries or data view queries depending on the context 

from which it has been opened.   

 

When opening QDM from the Design Management module, QDM displays the domain or data view 

which is currently selected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

QDM is displaying Clinical domain 

queries because the Clinical domain 

is currently selected. 
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When opening QDM from the Data Analysis module, QDM displays the data view which is currently 

selected for analysis.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

QDM is displaying Clinical data 

view queries because the Clinical 

data view is currently selected. 
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1.4 Query Groups 

 

Query Groups allow the grouping of Views, Filters and Queries to enable them to be managed more 

easily if a large number have been created.  Query groups behave like folders or directories.  Some 

default query groups are defined automatically.  Additional query groups can be defined within the 

default query groups. 

 

The  symbol indicates a query group. 

 

The symbol indicates a query. 

 

 

1.4.1 Query groups in a domain 

 

Within a Domain, two query groups are created by 

default for Subject Search queries and for Document 

queries.   

 

Queries can be copied and pasted between these two 

groups, however the two groups have their own 

purposes.  Queries should therefore be defined within 

the appropriate group or they may not be available for 

selection. 

 

Subject Search queries are for use in Data Entry.  

They are defined in QDM then selected in a data view 

definition in Design Management.  When selecting 

subject search queries within a data view definition, 

only queries within the Subject Search group are 

available for selection. 

 

Document queries are for use in document and report 

definitions.  When selecting queries within a 

document or report definition, only queries within the 

Document group are available for selection. 

 

Query subgroups can be created within each of the 

above groups to enable management of the queries. 

 

It is recommended that an appropriate structure of 

query groups and a naming convention for queries and 

query groups are used. 
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1.4.2 Query groups in a data view 

 

Within each Data View, a query group for Data Analysis queries is created by default.   

 

Within this Analysis Group, there are further default query groups -  a Global query group and a 

query group for each username.  Each user can see the Global group and the group corresponding to 

their own username.  This is true whether you are accessing data views in QDM from Design 

Management, Data Analysis or any other function.  Administrators have the additional option to view 

all usersô named query groups. 

 

Queries can be copied between groups within the Analysis group (and the Administrator can copy 

queries between the named usersô groups) but queries cannot be copied between data views. 

 

Query subgroups can be created within each of these groups to enable management of the queries. 

 

Queries created within the Analysis group are available whenever a function requires queries to be 

selected from a data view. 
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1.4.3 Viewing query groups belonging to other users 

 

By default, within a data view each user can view their own named query group in addition to the 

Global query group. 

 

In addition, Administrators can choose to view query groups belonging to other users. 

 

To view another userôs query group, open QDM for the appropriate data view. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Go to the Options menu and choose Select Users to Display. 

 

 

 

 

 

 

 

 

 

A list of users is displayed.  Select which usersô groups you wish to view. 
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After pressing OK, the selected usersô groups are displayed in QDM. 
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1.5 Defining query groups 

 

To define a query group, right click the parent group you wish to attach it to and choose New Query 

Group. 

 

 

 

 

 

 

 

 

 

 

 

 

 

A new query group is displayed on the tree. 

 

 

 

 

 

 

 

 

 

Give the query group a name that describes the queries that will be defined within it and then press 

return. 

 

 

 

 

 

 

 

 

The query group is displayed on each of the Queries, Views and Filters tabs. 
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1.6 Controlling the tree display in QDM 

 

By default, when you first open QDM, the initial view is of the first level of query groups created in 

the default query group. 

 

Initial view in a domain Initial view in a data view 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you expand the tree and then move between tabs, the tree is displayed in the same expanded state 

when you move back to that tab.  So each tab might be expanded to a different level, but each tab 

remembers the level that it was last expanded to.   However if you close then restart QDM all tabs 

return to the above default level. 

 

If you select a query then move to the Views tab, the Views tab automatically expands to display the 

view that belongs to the selected query.  Similarly if you select a query then move to the Filters tab, 

the Filters tab automatically expands the tree to display the filter that belongs to the selected query. 

 

If you wish the tree to be expanded to a different level on first opening QDM, you can add some 

registry settings.  The settings should be in Current User and in the InfoFlex\Query Design Manager 

section and are as follows: 

 

ExpandDefTreeTier  controls how expanded the Queries, Views and Filters trees are. 

ExpandItemTreeTier controls how expanded the Items tree is on the Views and Filters tabs. 

 

The default value for both if the registry settings are not defined is 1. 

 

Examples: 

 
ExpandDefTreeTier = 0 ExpandDefTreeTier = 1   ExpandDefTreeTier = 2 
 (default behaviour) 
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ExpandItemTreeTier = 0 ExpandItemTreeTier = 1   ExpandItemTreeTier = 2 
 (default behaviour) 
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1.7 Exercise 

 

Log into the InfoFlex CIMS General training database using the username training  and the 

password training . 

 

Go to Design Management and display the Clinical  domain and the Clinical  data view.  Ensure that 

both are unarchived. 

 

Select the Clinical Domain and then go to the Actions menu and choose Query Design Manager.  

Note that QDM displays the Clinical Domain. 

 

Note that the Document query group and Subject Search query group are attached to the domain.  

Some other query groups have been defined within these groups. 

 

Expand the Queries heading attached to the Subject Search query group.  Note the difference between 

the symbol for a query and the symbol for a query group. 

 

Close QDM. 

 

 

In Design Management, select the Clinical data view, then go to the Actions menu and choose Query 

Design Manager.  Note that QDM displays the Clinical Data view. 

 

Note that the Analysis query group is attached to the data view.  The Analysis query group contains 

the Global group and the training  group. 

 

Create two query groups within the training  query group.  Call them Training group 1 and Training 

group 2. 
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2 ABOUT QUERIES 

 

A query combines a view and a filter .  

 

 Views define which items of data will be displayed for the chosen group of patients.  A view can 

contain multiple data items from multiple events.  Functions can be applied to items in the view (for 

example to show the maximum, minimum or average of an item), and calculations can be carried out 

within a view (for example to add two values together). 

 

 Filters define the subset of data that is to be returned, i.e. which group of patients you wish to view 

(for example, all male patients, or all patients with a certain referral date or a certain consultant).  Filter 

criteria can be defined from any event in the design, and multiple criteria can be defined within one 

filter.   

 

You can also define filters which prompt the user for certain criteria when the query is run eg you can 

prompt for a consultant name or for a date range.  Prompts reduce the need to define multiple queries 

based on the same data item. 

 

 Queries join a particular view and filter together.  The resulting query returns a set of data which 

meets the view and filter criteria.   

 

Query parameters can be set to control the behaviour where view items or filter items come from 

multiple events.  Joining controls whether a subject can be returned if not all the events represented in 

the view exist for that subject.  Linking  controls which records are returned when filter criteria come 

from one or more repeat events.  These parameters will be explained later in this document. 
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2.1 Navigation 

 

In Query Design Manager there are three tabs: 

 

§ the Queries tab allows you to view, create and edit queries. 

§ the Views tab allows you to view, create and edit views.   

§ the Filters tab allows you to view, create and edit filters.   

 

Any structure of groups that you create is visible on each of the view, filter and query tabs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.1.1 Reviewing query definitions 

 

Whenever you select a definition in the navigation tree on one of the tabs in Query Design Manager, 

the contents or properties of the definition you have selected are displayed in the main section of the 

screen, bordered in blue: 

 

When you select a query in the navigation tree on the Queries tab, the view, filter and query 

parameters of the query are displayed.  The name of the query is displayed in the titlebar of the main 

window.  You should always double check that the correct name is displayed to ensure that you are 

viewing the correct query. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you have selected a query on the Queries tab, then when you move to the Views tab it will display 

whichever view is used in the selected query.  Similarly if you move to the Filters tab, it will display 

whichever filter is used in that query.  

 

The query name is 

displayed in the titlebar. 
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2.1.2 Reviewing view definitions 

 

When you select a view on the Views tab, the name of the view is displayed in the titlebar of the main 

window and the items that belong to that view are displayed in a grid beneath the titlebar.  (You should 

always double check that the correct name is displayed in the titlebar to ensure that you are viewing 

the correct view). 

 

The Query View Properties grid shows all the items that exist in the currently selected view.  Each 

row in the view is numbered, starting from zero.  (This numbering will be helpful when mapping 

queries into reports). 

 

The Items tree displays all the items in the current domain or data view.  Note that when working in a 

domain, the Items tree displays all the events and items in the domain.  When working in a data view, 

the Items tree displays the events, panels and items that exist in the data view that you are creating the 

view in. 

 

If you select a cell in the grid, the row number and column heading of the selected cell are highlighted 

in blue.  Additionally, the Items tree is expanded and the item is highlighted in the tree. 

 

Notice that in the Items tree, items that already belong to the view are displayed in red, and events 

(and panels) from which items are selected are also displayed in red. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The view name is 

displayed in the titlebar 

Select an item in the 

grid and it will be 

highlighted in the Items 

tree. 
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2.1.3 Reviewing filter definitions 

 

When you select a filter on the Filters tab, the name of the filter is displayed in the titlebar of the main 

window and the items that belong to that filter are displayed in a grid beneath the titlebar.  (You should 

always double check that the correct name is displayed in the titlebar to ensure that you are viewing 

the correct filter). 

 

The Items tree displays all the items in the current domain or data view.  Note that when working in a 

domain, the Items tree displays all the events and items in the domain.  When working in a data view, 

the Items tree displays the events, panels and items that exist in the data view that you are creating the 

view in. 

 

If you select an item in the grid, the Items tree will be expanded and the item will be highlighted in the 

tree. 

 

Notice that in the Items tree, items that already belong to the filter are displayed in red, and events 

(and panels) from which items have been selected are also displayed in red. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select an item in the 

grid and it will be 

highlighted in the Items 

tree. 

The filter name is 

displayed in the titlebar. 
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2.2 Exercise 

 

In QDM for the Clinical  data view, expand the Queries heading attached to the training  query group 

and select My query . 

 

Review the query definition. 

 

Go to the Views tab and note the My view is selected since it is the view used in the selected query.  

 

Review the view definition. 

 

Go to the Filters tab and note the My filter  is selected since it is the filter used in the selected query.  

 

Review the filter definition. 
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3 DEFINING  VIEWS 

 

3.1 Creating a view 

 

When defining views, they must be created within a query group.  You must create them in one of the 

default query groups (if you are in the domain, the Subject Search Query Group or the Document 

Query Group; if you are in the data view, the Global query group or your username query group).   

 

You can create views at the top level within a default query group, however it is recommended that 

you first define your own structure of query groups within the default query groups.  (See section 1.5 

Defining query groups). 

 

To define a view, right click the query group  

you wish it to belong to, and choose New. 

 

 

 

 

 

 

 

 

 

 

 

 

A new query is displayed in the query group.   

It is represented by the  symbol. 

 

 

 

 

 

 

Type a name for your view.  It is displayed next to the  symbol, and the name is also displayed in 

the titlebar of the main window.  You are now ready to add some items to your view. 
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3.2 Adding items to the view 

 

The Query View Properties section of the window displays the items that are defined in the view. 

 

To add items to a view, ensure that the correct view is selected, then open the Items tree to find the 

items that you wish to add. 

 

Note that when working in a domain, the Items tree displays all the events and items in the domain. 

When working in a data view, the Items tree displays the events, panels and items that exist in the 

selected data view. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can add items either by  

 

§ dragging them from the  

Items tree into the  

Query View Properties box. 

 

or by 

 

§ double clicking the item  

in the Items tree. 

 

 

Notice that items that have  

already been selected are  

displayed in red in the Items tree. 

 

Drag and drop, or 

double click an item 

Items tree in 

the domain 

Items tree in 

the data view 
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You can select as many items from as many different events as required.  You can also add the same 

item twice if necessary.  When you have finished, save the view by pressing F5 or press the Save 

button. 

 

Notice that as you add items to the view, they turn red in the tree, and the events and panels from 

which items have been selected are selected are also displayed in red. 

 

 
 

 

3.2.1 Re-ordering items 

 

Items can be re-ordered within a view 

by dragging and dropping. 

 

Pick up the grey cell to the left of the 

item you wish to move and drag it up 

or down.  Drop it when the grey 

horizontal line reaches the correct 

position. 

 

 

 

3.2.2 Deleting items from views 

 

To delete any item from a view, right click 

the row and select Delete. 

 

 

 

Drag and drop 



Chameleon Information Management Services Ltd  InfoFlex QDM User Guide 

July 2019  Page 24 

3.3 View Item Properties 

 

3.3.1 Formats 

 

It is possible to specify the format of date, value, coded and dictionary items.  These formats over-ride 

any formats that are set for the items in Design Management. 

 

Formats are set on the View tab of Query Design Manager in the Format column.  A dropdown list 

is displayed where it is possible to set a format.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.3.2 Options 

 

The Options column allows you to specify custom formats for Dictionary Lookup Items that are dates.  

This is free text data entry but the date format must be a valid date format, eg if you just want to 

display the month, enter mmm. 

 

3.3.3 Sort 

 

The Sort option allows you to order the data by a particular column.  To use this option, select either 

Asc or Desc in the Sort column for the item which you wish the data to be sorted by. 

 

3.3.4 Group by 

 

Group by is used in conjunction with the Count operator to calculate occurrences of a particular value 

in an item (see section 8.1 Occurrence Counting) and also with aggregated values (see section 9.3 

Aggregated values grouped by patient). 

 

3.3.5 Hide 

 

This is a simple tick option and allows you to hide the results from this column.  When the query is 

run, that column of data is simply omitted.  This option is particularly useful if you wish to temporarily 

anonymise data. 

 

3.3.6 Alias 

 

Alias  If you wish to specify your own column heading for a particular item, enter it in the Alias 

column.  By default no alias is set and the item name is used as the column heading.  Alias names can 

be up to 125 characters. 
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3.4 Deleting views 

 

To delete a view, right click the view and 

select Delete or use the Delete key on the 

keyboard. 

 

 

 

 

 

 

 

 

3.5 Exercise 

 

In the Training group 1 group, create a new view called Referral view. 

 

Add the following items: 

 

From the Patient Registration event:  

Hospital number, Surname, Date of Birth 

 

From the Referral event, Details panel:  

Appointment date, Date of referral 

 

From the Referral event, Assessment Details panel:  

Presenting Symptoms, Initial Diagnosis 

 

Set formats for the date items. 

 

Set formats for the dictionary and coded items (choose code & meaning). 

 

Save the view. 

 

 

 



Chameleon Information Management Services Ltd  InfoFlex QDM User Guide 

July 2019  Page 26 

4 DEFINING  FILTERS  

 

Filters allow you to specify a particular set of patients that you wish to view data for.  You can set up a 

filter that contains only one criteria, (eg all female patients, or all patients for a particular consultant) 

or you can set up a filter that combines several different criteria (eg all male patients of a particular age 

that had a particular type of surgery). 

 

4.1 Creating a filter  

 

To define a filter, go to the Filters tab, right click the 

query group you wish the filter to belong to, and choose 

New.  

 

 

 

 

 

 

 

 

 

 

A new filter is displayed in the query group.   

It is represented by the  symbol. 

 

 

 

 

 

 

 

 

 

 

 

Type a name for your 

filter.  It is displayed 

next to the  symbol, 

and the name is also 

displayed in the titlebar 

of the main window. 

You are now ready to 

add criteria to your 

filter. 
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4.2 Filter criteria  

 

The Query Filter Properties section of the screen displays the criteria that have been defined in the 

filter. 

 

Each filter criterion is made up of an item, an operator and a value.  The operator specifies how the 

data item is compared with the value. 

 

For example a filter criteria to return male patients would be defined as: 

 

 

 

 

 

 

 

 

 

4.2.1 Adding it ems to the filter 

 

To add an item to the filter, ensure that the correct filter is selected, then open the Items tree to find the 

items that you wish to add. 

 

Note that when working in a domain, the Items tree displays all the events and items in the domain.  

When working in a data view, the Items tree displays the events, panels and items that exist in the data 

view that you are creating the filter in. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

item comparison value 

Items tree in 

the domain 
Items tree in 

the data view 
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You can add items either by 

 

¶ dragging them from 

the Items tree into the 

Query Filter 

Properties box. 

 

or by 

 

¶ double clicking the 

item in the Items tree. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Notice that as you add items to the filter, the items you have added turn red in the tree, and the events 

and panels from which items have been selected are selected are also displayed in red. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Drag and drop, or 

double click an item 
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4.2.2 Operators 
 

Below is a list of the operators that can be used in filters and their meanings.  Some operators are only 

available for certain item types). 
 

Operator Meaning Item types 

= Equals All types except memo 

<> Not equal to  
 

Note that null values will not be returned when 

using this operator. 

eg a filter of ñDataItem <> 1ò will only return 

records with values entered and will not return 

records where DataItem has no value entered. An 

additional criteria of ñOR DataItem IS EMPTYò is 

required. 

All types except memo 

> Greater than All types except memo 

>= Greater than or equal to All types except memo 

< Less than All types except memo 

<= Less than or equal to All types except memo 

IN returns records where the item contains one of the 

values entered in the Value column 

All types except memo 

NOT IN returns records where the item does not contain one 

of the codes entered in the Value column 
 

Note that null values will not be returned when 

using this operator.   

eg a filter of ñDataItem NOT IN 1,2ò will only 

return records with values entered and will not 

return records where DataItem has no value 

entered.  An additional criteria of ñOR DataItem IS 

EMPTYò is required. 

All types except memo 

LIKE return records where the specified item contains the 

text entered in the value column.  The wildcard * 

can be used. 

All types including memo 

NOT LIKE return records where the specified item does not 

contain the text entered in the value column 

All types including memo 

IS EMPTY returns records where the specified item has no data 

entered and has not been marked with F11 or F12 

All types including memo 

IS NOT EMPTY returns records where the specified item does have 

data entered or has been marked with F11 or F12 

All types including memo 

IS NULL Behaves the same as IS EMPTY.  If you select IS 

NULL, the operator changes to IS EMPTY on 

saving. 

All types except memo 

IS NOT NULL Behaves the same as IS NOT EMPTY.  If you 

select IS NOT NULL, the operator changes to IS 

NOT EMPTY on saving. 

All types except memo 

IS KNOWN returns records where the specified item has data 

entered, or has been marked with F12, but has not 

been marked with F11 

All types except memo 

IS NOT KNOWN returns records where the specified item has had 

F11 entered 

All types except memo 

IS MISSING The item has been marked with F12 All types except memo 

IS NOT MISSING The item has not been marked with F12 but has 

data entered, or has been marked with F11 

All types except memo 

CONTAINS CODE returns records where the item contains the code 

specified in the Value column 

Multiple Response only 
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4.2.3 Entering values 

 

When entering values, the value needs to be entered in the same format as in Data Entry.  The Value 

column displays the same selection box that is used in data entry for the item. 

 

For Coded items, the Value column 

displays a dropdown list. 

 

 

 

 

For MR  items, the Value column 

displays a dropdown list and allows 

multi-selection. 

 

 

 

 

 

 

For Boolean items, the Value column 

displays the true and false text. 

 

 

For Dictionary  items, the Value column 

displays the dictionary search dialog. 

 

 

 

For Date items, the Value column 

displays the date picker and enters the 

date in the format set in the item 

definition. 

 

 

 

 

 

 

 

For Text items, the Value column 

allows free text entry and applies rules 

regarding case and max length that have 

been set.  The * wildcard can be used. 

 

For Value items, the Value column 

displays the format and unit set for the 

item. 

 

 

When you have created your filter, save it by pressing F5 or press the Save button. 
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4.3 Filters using multiple criteria  
 

If you wish to define a filter that uses more than one criterion, the criteria are linked together using 

operators. 
 

The AND operator returns records that fulfil both criteria. 
 

The OR operator returns records that fulfil either of the criteria. 

 

For example: 

 

This filter would return only those patients who were both male and single ie each patient has to meet 

both criteria in order to be returned. 

 

 
 

This filter would return all those patients who are male and would also return all those patients who are 

single ie each patient has to meet only one of the criteria in order to be returned. 

 

 
 

To add an AND or an OR, right click the row beneath which the AND or OR should appear, and 

choose Add Operator then the required operator. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The same item can be used more than once in a filter, if necessary. 
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4.4 Filters using a mixture of ANDs and ORs 

 

Where a mixture of ANDs and ORs are used in a filter, brackets can be used to define how the criteria 

are applied.  It is possible for the same criteria to return different results with a different arrangement 

of brackets. 

 

This filter: returns this set of patients: 

 

 

 

 

 

 

 

 

 

 

 

 

Whereas this filter: returns this set of patients: 

 

 

 

 

 

 

 

 

 

 

 

 

If no brackets were used, then the AND is applied first as in the first example. 

 

This filter applies the AND first: and returns this set of patients: 
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4.5 Re-ordering within filters  

 

When adding items and operators to filters, you can re-order them any time by dragging and dropping. 

 

Drag the grey square to the left of any item or operator and move it up or down in the grid. 

 

Drop the item or operator when the grey line is in the correct position. 

 

 

 

 

 

 

 

 

 

 

 

4.6 Deleting items from filters 

 

To delete any item from a filter, right click the row and select Delete. 

 

 
 

 

 

4.7 Deleting filters 

 

To delete a filter, right click the filter and 

select Delete or use the Delete key on the 

keyboard. 
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4.8 Examples of some filter criteria 

 

4.8.1 Filters using IN 
 

The IN  comparison returns records where an item contains one of several values entered in the Value 

column.  This comparison saves adding multiple criteria based on the same item linked with ORs.  

Note that when typing in multiple codes, they should be separated by semi-colons. 

 

This filter: 

 

 

 

 

 

 

 

 

Can be expressed as 

 

 

The NOT IN  comparison will return records where the value stored for the coded item is not one of 

the codes entered in the Value column.  Note though that null values will not be returned when using 

this operator.  eg a filter of ñDataItem NOT IN 1,2ò will only return records with values entered and 

will not return records where DataItem has no value entered.  An additional criteria of ñOR DataItem 

IS EMPTYò is required. 

 

4.8.2 Filters using CONTAINS CODE 

 

The CONTAINS CODE  comparison can only be used with multiple response (MR) coded items.  It 

returns records where the data entered in the MR coded item includes the code specified in the Value 

column.  The MR item may contain other codes as well as the one specified.  
 

 returns all records where 3 ï nausea  

This filter: exists in the Presenting Symptoms item 

 

 

 

 

 

CONTAINS CODE  can be used with AND, OR and NOT to define the filter further, however, 

brackets are required around the separate CONTAINS CODE clauses, eg: 

 

 

 

 

 

 

 

 

 

 

 

The example above will include all patients whose Presenting Symptoms item contains 0 ïpain but 

does not contain 3- nausea. eg  It would include "0;1"  and "0" , but not "0;1;3" . 
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4.8.3 Filters using LIKE  

 

The LIKE comparison returns records where the specified item contains the text entered in the value 

column.  This comparison can be used with text items, or to search dictionary codes.   

The * wildcard can be used. 

 

This filter returns all records where the surname begins with J. 

 

 

 

 

 

The NOT LIKE comparison will return records where the specified item does not contain the text 

entered in the value column of the filter. 

 

 

4.8.4 Filters using NULL 

 

The IS NULL  comparison will return records where the specified item has no data entered and has not 

been marked with F11 or F12. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The IS NOT NULL  comparison will return records where the specified item does have data entered or 

has been marked with F11 or F12. 
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4.8.5 Filters using KNOWN 

 

The IS NOT KNOWN comparison returns records where the specified item has had F11 entered.   

F11 puts a green highlight on the item in data entry, and displays ï88888 in Data Analysis. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The IS KNOWN comparison returns records where the specified item has data entered, or has been 

marked with F12, but has not been marked with F11. 

 

 

 

 

 

 

 

 

 

 

4.8.6 Filters using MISSING 

 

The IS MISSING comparison returns records where the specified item has had F12 entered.   

F12 puts a blue highlight on the item in data entry, and displays ï99999 in Data Analysis. 

 

 

 

 

 

 

The IS NOT MISSING comparison will return records where the specified item has data entered, or 

has been marked with F11, but has not been marked with F12. 
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4.8.7 Filtering with memo items 

 

Only the LIKE, NOT LIKE, IS EMPTY and IS NOT EMPTY operators can be used with memo items. 

 

To retrieve memo items that are either empty or null, the following syntax should be used: 

 

 

 

 

 

 

 

 

 

 

 

 

To retrieve memo items that are not null or not empty, the following syntax should be used: 

 

 

 

 

 

 

 

 

 

2 x single quotes 

For each of these rows, add an 

expression then type the text 

shown into the Value column. 

2 x single quotes 

For this row, add an expression 

then type the text shown into the 

Value column. 
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4.9 Exercise 

 

1 In the Training group 1 group, create a new filter called Referral filter . 

 

Add the following items: 

 

From the Referral event, Details panel:  

Date of referral 

 

In the Operator column, select > 

 

In the Value column enter 01/01/2000. 

 

Save the filter. 

 

2 Create a filter to find patients who are both female and have the GP with code X9870004 

 

3 Create a filter to find patients whose surname is Smith or Jones and who are aged over 60 (use 

the Age item on the Assessment Details panel of the Referral event). 

 

4 Create a filter to find Referrals where the source of referral is 0 ï GP, 1 ï A&E, or 2 ï Dentist. 

 

5 Create a filter to find Referrals where the patientôs Presenting Symptoms include 3 ï nausea. 
 

6 Create a filter to find Referrals where the Source of Referral is marked as Missing. 
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5 DEFINING A QUERY  

 

5.1 Creating a query 

 

To define a query, go to the Queries tab, right click the 

query group you wish the query to belong to, and 

choose New.  

 

 

 

 

 

 

 

 

 

 

 

 

A new query is displayed in the query group.   

It is represented by the  symbol. 

 

 

 

 

 

 

 

 

 

Type a name for your 

query.  It is displayed 

next to the  symbol, 

and the name is also 

displayed in the titlebar 

of the main window. 

You are now ready to 

define the properties of 

your query 
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5.2 Adding properties to a query 

 

The following properties can be set in a query. 

 

5.2.1 Description 

 

A free text description for reference. 

 

 

5.2.2 View 

 

To select a view, use the  

button to display a list of the 

available views.  The list displays 

the Global group and the userôs 

own named group as well as any 

subgroups, and the views that 

have been defined within each 

group.  To select a view, double 

click it. 

 

 

 

 

 

 

 

After selecting a view, it is 

displayed in the View field. 

 

 

 

5.2.3 Filter  

 

To select a filter, use the  

button to display a list of the 

available filters.  The list 

displays the Global group and 

the userôs own named group 

as well as any subgroups, and 

the filters that have been 

defined within each group.  To 

select a filter, double click it. 

 

 

 

 

After double clicking a filter, 

it is displayed in the Filter  

field. 
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5.2.4 Link at  

 

The link level is used where the filter contains criteria from multiple events.  The link level is the level 

in the design tree beneath which the filter criteria must be met.  By default, InfoFlex sets the lowest 

possible common parent as the link level. 
 

See section 7.2 About Linkin g for further details. 
 

 

5.2.5 Outer Join 

 

The Join controls whether or not a subjectôs events can be retrieved when the view contains items 

from several different events and not all of the events used in the view exist for that subject.  (This is in 

addition to the criteria defined in the filter.) 
 

When Outer Join is set to Yes, a subject will be returned if they satisfy the criteria of the filter and as 

long as at least one of the events represented in the view exists for that subject. 
 

When Outer Join is set to No (ie Inner Join is set), a subject is only returned if they satisfy the 

criteria of the filter and if every event used in the view exists for that subject.  (Note that it is the event 

that must exist - data does not have to exist in every item used in the view as long as every event used 

in the view exists). 
 

When a query is first created, if the selected query view or event view only has one event represented, 

the join type will default to Inner Join .  Otherwise, Outer Join is set.  Note that once the join has 

been set, it will not subsequently change automatically.  This is true whether the query view or event 

view is changed, or whether the query view itself is edited. 

See section 7.4 Joining for further details. 

 

 

5.2.6 Distinct Rows 
 

In some circumstances, the combination of the link level and the data items being returned will cause 

the same record to be returned more than once in result set.  Setting Distinct Rows to Yes prevents this 

happening. 
 

By default, Distinct Rows is set to No. 
 

See section 7.3 Distinct Rows for further details. 

 

 

5.2.7 Context 

 

The Context parameter is relevant when queries are used in documents and reports.  The Context 

parameter sets a lowest common parent for the data that is returned in the document.  See the Report 

Definition and Document definition user guides for further information. 

 

 

5.2.8 User-defined 

 

User-Defined allows users to write their own SQL queries rather than defining views and filters. 
 

See section 7.6 User-defined for further details. 
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5.3 Running a query 

 

After defining a query, save it by pressing F5 or the Save button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To view the query results, press the  Run button on the toolbar. 

 

Note that if you make any changes to a query (for instance selecting a different view or filter, or 

changing the Link or Join), and then run the query without saving, there will be a prompt to save.  If 

you save, the new saved query will be run, and if you do not save, the unsaved query will be run rather 

than the saved query. 

 

The query results are displayed in the Results grid below the Queries tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Number of records 

returned is indicated here. 
Click a column heading to order 

the results by that column. 
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5.3.1 Studies and queries 

 

When a query is run from a domain, you are prompted for a data view to run it against.  The data view 

filters the results so that only those events that are flagged as belonging to any of the studies in the data 

view's study list are returned.  Therefore if events represented in the view exist for a patient but the 

events do not belong to any studies represented in the selected data view, those events will not be 

returned in the query results. 

 

 
 

 

5.3.2 Testing query results 

 

When you are defining a query for use for example in a report, you should always run it in QDM first 

to ensure that the query is returning the results you expect. 

 

For testing purposes, it can be helpful to include in your view the items that are being used in the filter, 

even if those items are not needed in the final version of the query. 

 

For example, your query might be returning a list of patients who were referred within a certain time 

period.   

 

 

 

 

 

 

The report may not need to display the Date of Referral for each patient, but while you are testing 

your query it is useful to add the Date of Referral to the view so that you can ensure the results are 

correct.  Once the query is producing the correct results, you can remove the Date of Referral from 

the view. 

 

 

 

 

 

 

 

 

 

 

Add the Date of Referral filter criteria to the 

view to ensure that the results are correct. 
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5.3.3 Viewing SQL 

 

You can view the SQL that is created by your view, filter or query definition. 

 

The View menu has an SQL option which is available whether you are 

working in the Queries, Views or Filters tab.   

 

When this option is switched on, an SQL panel is displayed at the bottom of 

the tab and the SQL represented by the current view, filter or query is 

displayed.  Note that you should save your view, filter or query to ensure that 

the SQL is up to date.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

On the Queries 

tab, the SQL is 

always available 

when a query has 

been run.  An 

SQL tab is 

displayed next to 

the Results tab. 

 

 

 

 

 

 

 

SQL panel ï switched on 

and off in the View menu. 
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5.4 Event counting 

 

When defining a query, instead of selecting a view, you can choose to count the number of events that 

meet the filter criteria.  This is done by using the Event Counts function. 

Instead of returning data items, the query will simply count how many occurrences of the selected 

event match the filter criteria. 

 

In the View selection box, press the Event Counts button instead of using the dropdown list of views. 

The event tree is displayed and you may select any event.   

 

 
 

On saving, the View property displays Count of followed by the name of the event selected.  

Also on saving, Distinct Rows is automatically set to Yes 

 

 

 

 

 

 

 

 

 

 

 

 

 

When this query is run, one value is returned, which is the number of events that match the filter 

criteria. 
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5.5 Deleting queries 

 

To delete a query, right click the query and 

select Delete or use the Delete key on the 

keyboard. 

 

 

 

 

 

 

 

 

 

5.6 Exercise 

 

1 In training group 1, create a query called Referral query. 

 

Set Referral view as the view. 

 

Set Referral filter  as the filter. 

 

Save and run the query. 

Note that since Date of Referral is in the view so you can easily check that the right data is being 

returned (the filter is Date of referral > 1/1/2000). 

 

2 View the SQL on the Queries, Views and Filter s tabs. 

 

3 Make a copy of the query in the same group. 

 

In the copy, set the view to Count of the Referral event. 

 

Save and run the query.  One row is returned which is the number of Referral events that meet 

the filter criteria. 
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6 PROMPT FILTERS  

 

6.1 Defining a prompt filter  

 

Prompts in filters allow the user to specify filter values when the query is run, rather than having to 

continually update the value specified in the filter itself.  For example if a weekly report is run the user 

can be prompted to enter the date range every time the query is run rather than editing the filter every 

week, or if the same report is required for several different consultants, one prompt filter can be 

defined and the user can be prompted for the consultant name on running the query rather than 

defining one query for each consultant. 

 

To define a prompt filter, create a filter and add an item and operator as usual.  Instead of entering a 

value in the Value column, tick the check box in the Prompt column. 

 

 

 

 

 

 

A filter used in a report which run for a prompted date range might look like this.  The user is 

prompted for the start date and the end date. 

 

 

 

 

 

 

 

 

Help Text 

 

The text in the Help Text column is displayed when the query is run to indicate to the user the value 

that is required.  You can specify the text that is displayed. 

 

Default value 

 

If you wish the prompted field be populated with a default value, enter it in the Default Value column.  

This value can be over-written by the user when the query is run. 

 

The Information functions USER, COMPUTERNAME, WINGROUPS and WINUSER can be used as 

default values. 

 

For example, if USER is selected as the default value, then when the query is run, InfoFlex will still 

prompt the user, but the default value of the current userôs username will be supplied as the prompt 

value, so that the user can just OK the prompt without changing the value. If they need to supply a 

different value from the default then they are able to change the value as normal. 
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The prompts will work in Worklist, Data Analysis, Reporting, Documents, Subject Search Queries, 

etc. They also work with add-ins such as the Summary Doc Addin and the Correspondence Addin and 

Extract Addin. 

The batch process (with the profile that generates/prints/emails reports) does not allow prompting. 

Although default values are usually used automatically, the information functions above are user-based 

and will not work here.  

The Multiple-Reports add-in is not able to make use of these default values. 

 

Parameter name 

 

The Parameter Name column is for use if the prompted value needs to be printed on a report.  The 

parameter name is included as a document item on the document template, and is substituted for the 

prompted value when the report is generated.  (See section 6.1 of the Report Definition manual). 

 

The Parameter Name column can also be used if the same parameter is used more than once in the 

filter.  If the same parameter name is used against each instance of the parameter, it will only be 

prompted for once.  The entered value will automatically be used in each subsequent occurrence of the 

parameter without further prompting. 

 

 

Running a query containing a prompt filter 

 

When a query containing a prompt filter is run, a Parameters box is displayed listing all the items that 

have been set as prompt items.  The Parameter column contains the help text that has been entered for 

the item. 

 

 

 

 

 

Enter values in the value column for both of the items then press OK. 

 

 

 

 

 

 

The results are returned in the Results grid as usual. 

 

 

 

 

 

 

 

 

 

 



Chameleon Information Management Services Ltd  InfoFlex QDM User Guide 

July 2019  Page 49 

6.2 Exercise 

 

1 Create a filter in Training group 1 called Prompt filter .  

Set it to prompt for a date range for Date of Referral (ie prompt for earliest and latest Date of 

Referral). 

Set prompt text for each parameter. 

Save the filter. 

 

2 Create a new query in the Training group 1 called Prompt query. 

Select Referral View and Prompt filter . 

Save and run the query. 

Enter dates of 1/1/2000 and today. 

Then rerun the query with dates of 1/7/2000 and 31/7/2000. 
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7 QUERY PARAMETERS  

 

7.1 Types of query 

 

Simple queries use data from one off events, or data from the first level of a repeat event. 

 

Complex Queries can use Complex Views and Complex Filters.   

Complex Views can include data items from several events (including repeat events) at several levels.  

Complex Filters can include criteria from different events.   

In the case of Complex Queries, different results can be returned depending on the way the Link ing 

and Joining parameters are set in the query. 

 

7.2 About Linkin g 
 

Where filter criteria are taken from multiple events, the Link Level controls the way the filter criteria 

are applied to the View and hence affects which set of data is returned. 

 

The Link Level is the level in the design tree beneath which the filter criteria must be met.  The event 

at which the link level is set is known as the common parent.  The filter criteria must be met in child 

events of that common parent. 
 

For example.  In this design, filter criteria might 

be defined using items from the Admission & 

Surgical event and from the Radiotherapy 

event. 

 

 

The filter might be to return all Referrals where 

Date of Admission >= 01/01/2001 (from the 

Admission event) and Radiotherapy = type A 

(from the Radiotherapy event). 

 

 

Consider this subject overview: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1  Patient Registration 

 1  Referral A 

  1  Admission 

   Date = 01/01/2000 

  1  Radiotherapy 

   Type = Type A 

 1  Referral B 

  1  Admission 

   Date = 01/01/2001 

  1  Radiotherapy 

   Type = Type A 

 1  Referral C 

  1  Admission 

   Date = 01/01/2002 

  1  Radiotherapy 

   Type = Type B 

Meets criteria when link 

set at Referral level. 

Meets criteria when link set at 

Patient Registration level. 

Meets criteria only when link set 

at Patient Registration level. 
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The link level specifies whether these criteria must be fulfilled within the same Referral event, or 

whether the criteria can be fulfilled across different occurrences of the Referral event. 

 

When determining which Referral events meet the criteria: 

 

§ if the link level is set at the Referral event, the Referral event is the Common Parent and in 

order for a particular referral event to be returned, the filter criteria must all be met in child 

events of that referral.  In the example above, the criteria are only met within Referral B. 

 

§ if the link level is set at the Patient Demographics event, the Patient Demographics event is 

the Common Parent and Referral events can be returned as long as the filter criteria are met 

somewhere within the patient.  In the example above, all the Referral events would be 

returned.   

 

So, with the link level set at 

Referral, only one record is 

returned. 

 

 

But with the link level set at Patient Registration, 12 records are returned.  This is because there are 

four combinations of ways that the filter criteria can be met within the subject overview, and these four 

ways are listed once for each of the three Referral events. 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The coloured arrows mark the 

four ways in which the filter 

criteria are met across the subject. 

The coloured dots 

correspond to the 

ways that the filter 

criteria are met 

(illustrated in the 

subject overview 

below).   

Each way is listed 

once against each 

referral event. 

Referral A 

Referral B 

Referral C 

1  Patient Registration 

 1  Referral A 

  1  Admission 

   Date = 01/01/2000 

  1  Radiotherapy 

   Type = Type A 

 1  Referral B 

  1  Admission 

   Date = 01/01/2001 

  1  Radiotherapy 

   Type = Type A 

 1  Referral C 

  1  Admission 

   Date = 01/01/2002 

  1  Radiotherapy 

   Type = Type B 
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7.2.1 How to set the Link Level 

 

To set the Link Level, edit the query and press the  button in the Link at  property. 

Double click the event which you wish to set as the Common Parent. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

By default, no link level is shown within a query definition and InfoFlex uses the lowest possible 

common parent as the link level.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chameleon Information Management Services Ltd  InfoFlex QDM User Guide 

July 2019  Page 53 

7.2.2 Exercise 

 

This exercise recreates the example described in section 7.2 above. 

 

 

In the Training Data view, create a view called Link example as follows: 

From the Patient Registration event: Hospital number 

From the Referral event, Details panel: Appointment date 

From the Admission & Surgical event, Surgery Details panel: Date of Admission 

From the Radiotherapy event: Date of this radiotherapy, Type of Radiotherapy 

 

Create a filter called Link example as follows: 

Date of Admission >= 01/01/2001 (Admission & Surgical event) 

AND 

Type of radiotherapy = Type A (Radiotherapy event) 

 

Create a query called Link example and select the Link example view and the Link example filter. 

 

Set the Link level to the Referral event, then save and run the query. 

 

With the link level set at the Referral level, the filter criteria must be met within the same Referral 

event. 

 

1 record is returned, as there is only 1 record where the criteria are met within the same Referral. 

 

Set the Link level to the Patient Registration event, then save and run the query. 

 

With the link level set at the Patient Registration level, the filter criteria can be met anywhere within 

the patient.  12 records are returned.  This is because using the Admission and Radiotherapy events 

from anywhere in the subject overview, there are 4 different ways in which the criteria can be met and 

these are listed for each of the 3 Referral events. Order the grid by Appointment date to see this 

more clearly. 

 

 

The subject overview for the patient in question is as shown below. 

If you wish to review the data, go to Data Entry and in the Training data view, search for the patient 

with a Hospital Number of LINK TEST PATIENT . 

 
 1  Patient Registration 

 1  Referral 

  1  Admission 

   Date = 01/01/2000 

  1  Radiotherapy 

   Type = Type A 

 1  Referral 

  1  Admission 

   Date = 01/01/2001 

  1  Radiotherapy 

   Type = Type A 

 1  Referral 

  1  Admission 

   Date = 01/01/2002 

  1  Radiotherapy 

   Type = Type B 

 

Meets criteria when link 

set at Referral level. 

Meets criteria when link set at 

Patient Registration level. 

Meets criteria only when link set 

at Patient Registration level. 
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7.3 Distinct Rows 

 

As we have seen above, the number of records returned matches the number of combinations in which 

the filter criteria can be met within the events, regardless of which items are included in the view.   

 

In the example above, with the link level set at Patient Registration, 12 records were returned.   

Since the items in the view come from several repeating events at the same level, each record returned 

represents each different combination of the data. 

 

With the filter described above in the Link example, these results are displayed: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If the view only contained items from the Patient Registration and Referral events, 12 records would 

be returned, and some of the records would look the same since the different data items that distinguish 

them would not be included in the view.  In this case, you can choose to display Distinct Rows in 

order to remove the apparent duplicates. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

With the same filter but fewer items in 

the view, the same records are displayed, 

but now there are no items from the 

Admission or Radiotherapy events to 

distinguish one record from another. 

 

Setting Distinct Rows to Yes will reduce 

the results to show distinct records only. 
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7.3.1 How to set Distinct Rows 

 

To switch on Distinct Rows, edit the query and set the Distinct Rows property to Yes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note that by default, Distinct Rows is set to No. 

 

 

 

 

7.3.2 Exercise 

 

This exercise recreates the example described in section 7.3above. 

 

 

Edit the Link example view created in the Linking exercise in 7.2.2above. 

 

Delete the last 3 items in the view so that the view only contains Hospital Number and Appointment 

Date.  Save the view. 

 

Run the Link  Example query with the link level set at the Patient Registration event. 

 

12 records are returned, but since the items from the child events are not present, there appear to be 

duplicate records. 

 

Set Distinct Rows to Yes. 

 

Save then rerun the query.  The duplicate rows are removed and now only 3 records are returned. 
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7.4 Joining 
 

Joining affects which set of data is returned when multiple events are represented in a view.  This is in 

addition to the criteria defined in the filter.  Joining controls whether or not a record can be retrieved 

where not all of the events used in the view exist for that subject. 
 

When Outer Join is set to Yes, a subject will be returned as long as they satisfy the filter criteria and 

as long as at least one event used in the view exists for that subject. 
 

When Outer Join is set to No (ie Inner Join is set), a subject is only returned if every event 

represented in the view exists for that subject.  (Note that it is the event that must exist - data does not 

have to exist in every item used in the view as long as every event used in the view exists.  If there is 

no data in any of the items in the view, a blank row is returned.) 
 

For example:  In this design: 

 

 

 

 

 

a view is created which contains items from 

both the Patient Registration event and the 

Referral event. 

 

(In this example, no filter criteria are 

defined so all patients are available) 

 

Outer Join 
 

When this view is run in a query with an Outer Join (and no filter criteria), 19 records are returned, 

however the last 5 records do not show any data against the items from the Referral event.  The 

Appointment Date item is the identifier of the event and it is included in the view so we can be sure 

that the Referral event does not exist for these 5 records.   
 

The 5 records are included because the Patient Registration event which is represented in the view 

does exist for them, and an Outer Join will return a record as long as at least one event represented in 

the view exists.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The event 

identifier of the 

Referral event. 

These patients 

have no 

Referral event 



Chameleon Information Management Services Ltd  InfoFlex QDM User Guide 

July 2019  Page 57 

Inner Join 

 

However when the same view is run in the same query (and no filter criteria) but with an Inner Join, 

only 14 records are returned.  The 5 records with no Referral event are omitted because Inner Join 

specifies that a record can only be returned when all events represented in the view exist. 

 

 
 

 

7.4.1 How to set the Join 

 

To set the query to Outer Join, edit the query and set the Outer Join property to Yes. 

 

To set the query to Inner Join, edit the query and set the Outer Join property to No. 

 

 
 

Default Outer Join setting 

 

When a query is first created, if the selected query view or event view only has only one event 

represented, the join type will default to Inner Join .  Otherwise, Outer Join is set.  Note that once the 

join has been set, it will not subsequently change automatically.  This is true whether the query view or 

event view is changed, or whether the query view itself is edited. 

 

 



Chameleon Information Management Services Ltd  InfoFlex QDM User Guide 

July 2019  Page 58 

 

7.4.2 Exercise 

 

This exercise recreates the example described in section 7.4above. 

 

 

In the Clinical Data view, create a new filter in the Training group 1 called All patients.   

Set the criteria to Hospital Number IS NOT EMPTY . 

 

In the Clinical Data view, create a new query in the Training group 1 called Join Example.   

Select the Referral View view and the All patients filter. 

 

Save the query with Outer Join set to Yes. 

 

Run the query. 

20 records are returned.   

Order the records by Appointment Date and note that some of the records have no Appointment Date.  

Since Appointment Date is the event identifier of the Referral event, this means that those records have 

no referral event. 

 

Set Outer Join to No.  Save then re-run the query. 

 

This time 15 records are returned.  This is because records are only returned if all the events that are 

represented in the view exist. 

 

 

 

 

 

 

 

 

 

 

 



Chameleon Information Management Services Ltd  InfoFlex QDM User Guide 

July 2019  Page 59 

7.5 Context 

 

The Context parameter is relevant when queries are used in documents and reports.  The Context 

parameter sets a lowest common parent for the data that is returned in the document.  See the Report 

Definition and Document definition user guides for further information. 

 

 

7.6 User-defined 

 

Querying functions that are not currently available in QDM can be requested through the CIMS 

helpdesk.  Agreed functions that are developed are released to all customers.  However, in the event of 

an urgent requirement, users may write their own SQL instead of using InfoFlex views and filters.  

Please contact CIMS helpdesk if you think you need to use this function. 

 

 

If it is agreed that user-defined SQL is required, set User-Defined to Yes and press the  button to 

display.  A User-defined SQL box is displayed in which to enter your own SQL. 

 

Note that on setting User-Defined to Yes, any selected view and filter are removed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note that where a coded item is included in a SELECT statement, the Coded Items option on the 

Options menu controls the format that the data is returned in. 
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8 VIEW PARAMETERS  ï OCCURRENCE COUNTING  

 

8.1 Occurrence Counting 

 

Occurrence counting counts the number of times that each value entered in an item occurs.  This 

function can be used, for example to count how many times each source of referral has occurred.  

Occurrence counting has to be used with the Group by function.   

 

To count the number of times that each item value occurs, add the item that you wish to count to a 

view and tick the Group By column. 

 

 
 

Right click the item and choose Add Operator then Count. 

 

 
 

A second row displays the Count command. 
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When this view is run in a query, the results show the number of times each value entered in the 

Source of Referral item has been used. 

 

 

 

 

 

 

 

 

 

This function can be used with coded, boolean, dictionary, date, text and value items. 

 

 

 

 

 

 

 

 

 

 

This function can also be used with more than one item to show the number of times a combination of 

values occurs.   

Each item must have the Group By option ticked. 

 

 

 

 

 

 

 

 

The results show the number of times each combination of values has been entered. 
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8.2 Exercise 

 

In the Clinical Data View, in Training group 1, create a view called Occurrence counting. 

 

Add the Source of Referral (Referral event, Details panel) and set the format to Code and Meaning 

and tick the Group By column. 

 

In the second row of the view, add the Count operator from the right click menu. 

 

Save the view. 

 

In Training group 1, create a query called Occurrence Counting. 

 

Select the Occurrence Counting view and the All patients filter. 

 

Run the query. 

 

These results should be returned: 

 

 

 

 

 

 

 

 

 

Add the Category item (Referral event, Details panel) to the Occurrence Counting view. 

Set the format to Code and Meaning and tick the Group By column. 

Move Category to be the second row in the view. 

Save the view. 

 

Rerun the Occurrence Counting query. 

 

These results should be returned: 

 

 

 

 

 

 

 

 

 

 

 

 

 


























































































